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1. Getting Started

Thank You
Thank you for purchasing Anaheim Automation’s LC controls, the affordable,
powerful CNC control system for Windows.  No other CNC system is easier to
set up and use than the LC.  We’re sure you’ll enjoy easy to use menus and real
time graphics as you quickly and accurately cut parts on your machine tool.

We are committed to the excellence of the LC controls.  Feel free to call us with
any comments or questions.

Product Support
We are committed to full support of the LC controller product line.  There are
three support options:

Phone: (714) 992-6990 8:00 AM-5:00 PM, Pac. Time, M-F

Fax: (714) 992-0471 24 hours a day, 7 days a week.

E-mail: support@anaheimautomation.com 24 hours a day, 7 days a week.

Web Site: www.anaheimautomation.com 24 hours a day, 7 days a week.

System Requirements
• IBM PC or 100% compatible with a 66MHz or faster 80486DX, Pentium, or

higher CPU.

• At least 8MB of RAM.

• Hard drive with at least 20MB of space available.

• 3.5 inch, 1.44-MB floppy disk drives.

• VGA, SVGA or compatible video monitor.

• A Microsoft-compatible mouse.  Note that for best performance, the mouse
should connect directly to the bus (the standard mouse plug on most systems),
or through a mouse bus port rather than through a serial port.

• One available RS-232 serial port. If the port has a 25-pin connector, a 9-pin
male to 25-pin female adapter will be required.

• Microsoft Windows 95, 98 or NT or Microsoft or PC DOS version 3.1 or later
running Microsoft Windows version 3.1 or 3.11.

Section
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Installing LC
It’s a good idea to make a working copy of the LC software disks and put the
originals away in a safe place, before installing the program. Then if the working
copy is damaged or lost, you can easily replace it.

If you are using Windows 3.1 or 3.11:

1.  Start Windows

2.  Place Disk 1 into drive A or drive B.

3.  In the Windows Program Manager, choose the Run command from the
File menu.  In the Command Line text box, type a:setup if you are
using disk drive A or b:setup if you are using disk drive B.  Choose
the OK button and follow the on-screen instructions.

4.  To run LC simply double-click on the AA icon in the AA program
group.

If you are using Windows 95, 98 or NT:

1.  Start Windows

2.  Place Disk 1 into Drive A or Drive B.

3.  From the Start menu, choose the Run option.  In the Open text box,
type a:setup if you are using disk drive A or b:setup if you are using
disk drive B.  Choose the OK button and follow the on-screen
instructions.

4.  To Run LC, choose the Programs option from the Start menu, then
choose the LC program group, then choose the LC program icon.

Using the Mouse
Most mice have two buttons.  When using LC software, always use the left mouse
button unless specifically instructed otherwise.  The following table explains
basic terms associated with using the mouse.

To                    Do this                                                                                                

Point Position the pointer (arrow) on an item.

Click Point to an item, and then quickly press and release the mouse
button.

Double-click Point to an item and then quickly press and release the mouse
button twice.

Drag Point to an item, press and hold the mouse button as you move the
mouse to a new location.  Then release the mouse button.

Hold Point to an item, press and hold the mouse button.
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Choosing Commands
A command is an instruction that tells the LC to perform a task.  You can choose
a command by:

1. Choosing a command from a menu with your mouse.

2. Choosing a command from a menu with your keyboard.

3. Using shortcut keys.

4. Using the TAB and ARROW keys.

Choosing a Command by Using the Mouse

Click the name of a menu item on the menu bar, then click the command
name. To close the menu without choosing a command, click outside the
menu.

Choosing a Command by Using the Keyboard

 Press ALT or F10 to make the menu bar active, and then press the key
corresponding to underlined letter in the menu name.  To choose a
command, press the key corresponding to the underlined letter in the
command name. To close a menu without choosing a command, press
ESC.

Using Shortcut Keys

 Some of the LC commands have shortcut keys associated with them.  You
can choose these commands by pressing the shortcut keys listed on the
menu to the right of the command.

Using the TAB and ARROW Keys

 The TAB key and ARROW keys can be used to navigate through the
currently active screen selections.  Once the selection that you want is
highlighted, use the RETURN key to select it.

Using Standard Windows Controls
The LC software uses several standard Windows controls: radio buttons, pull
down menus, text boxes and command buttons.

Radio Buttons

 Radio buttons represent a group of options, of which only one can be
selected at a time, just like the channel buttons on your car radio.
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Pull-Down Menus

 A pull-down menu is a list of commands that appear when you select
either a menu or a down-arrow icon.

Text Boxes

 Text boxes are areas in which you type either a name or a value.

Command Buttons

 Command buttons perform a specific task when selected.

  

Pull-Down
Menu

Text Box

Command
Button

Radio
Buttons
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System Safety

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

If you do not understand and agree with all of the above safety
guidelines, do not use this product.

1.  Never let the machine run unattended.

2.  Any person near a running machine tool must wear safety goggles.

3.  Allow only trained people to operate the machine. Anyone operating
this machine must have:

• Knowledge of machine tool operation.

• Knowledge of personal computer operation.

• Knowledge of Microsoft Windows .

• Good common sense.

4.  Place safety guards around the machine to prevent injury from flying
objects.  Anaheim Automation highly recommends building a
plexiglass safety shield around the entire tool envelope.

5.  A computer-controlled machine tool is potentially dangerous.
Unexpected machine movement can occur at any time.  Never place
any part of your body within the tool envelope while the machine is
online.

6.  Be aware and on alert for computer crashes at all times.

7.  Always keep the tool envelope tidy and free of any loose objects.

8.  Anaheim Automation is not responsible for the safe installation and
use of this product. You and only you are responsible for the safety
of yourself and others during the operation of your CNC machine
tool.  Anaheim Automation supplies this product but has no control
over how it is installed or used.  Always be careful!

When running any machining operation, safety is of utmost
importance. For proper and safe use of the LC controls and
your CNC machine, the following safety guidelines must be
followed:
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About this Manual
Anaheim Automation’s LC software is a unique Windows application, so you’ll
need some instruction to get started.  Since automated machining is potentially
dangerous, please take the time to completely read through this manual to
understand the operation of the software and machine before cutting a part.

Please note that all LC terminology appears in boldface upon first occurrence and
is defined in the glossary.

It is assumed that you already have a working knowledge of the PC and
Windows.  If you are not familiar with either of these, please review your PC or
Windows user’s guides before you use the LC controller.

Program Overview
Anaheim Automation’s LC software is a Windows based program that gives you
direct control of your machine tool while displaying real time graphics. With
Anaheim Automation’s LC software you can:

• Visualize and verify the tool path generated from a G-Code file.

• Watch the current position of the machine tool as it moves.

• See the current position of the machine tool in either Machine, Program,
Relative, or Distance-To-Go coordinates.

• Create, edit and display a G-Code program.

• Move the machine tools in any of four different modes: Jog, Point, G-Code, or
Home.

• Import DXF files.
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2. Main Screen Features
The main screen is shown below. An explanation of each area of the screen
follows.

l

Pull Down Menu Bar
This area contains the main menu headings for many system commands.

File Menu

Open G-Code - Opens an existing G-Code file, checks the file for errors and
compatibility with the LC software, draws the tool path in the Tool Path View

Pull-down
Menu Bar

Tool Position
Box

Tool Path
View-Port

Program
Listing Box

Control Box

Message Box

Section
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Port, and displays the program in the Program Listing Box.  By default, the dialog
box displays files with an “.AGC” extension.

Close G-Code – Closes the open G-Code file.

Editor - Opens the editor dialog box and displays the current G-Code file.  Using
this feature you can directly edit any G-Code file without leaving Anaheim
Automation’s LC software.  Note that you can also double-click the Program
Listing Box to open the editor.

Open Setup - Opens a file containing all CNC Setup Parameters for your
machine tool.  You can set these parameters using commands in the Setup and
View menus described below.  Setup file names have a “.STP” extension by
default.

Save Setup - Saves the current CNC setup parameters under any file name in any
directory.

Save Setup As - Prompts you for a file name in which to save the current CNC
Setup Parameters.

Import DXF - Directly translates a 2-dimensional DXF file into G-Code for use in
Anaheim Automation’s LC software.

Exit - Closes the communications port to the controller, then exits the program.
This does not automatically turn off the controller.  You must turn off the
controller separately.

Setup Menu

Machine Tool, Feedrate/Ramping, Tooling, Input Lines, Output Lines, Motor
Signals, G/M Codes, Import, System Options - Open dialog boxes where you’ll
enter your CNC setup parameters, such as the size of your machine tool envelope
or the configuration of your LC Controller.  These parameters are described in
detail later in the manual.
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Controller Menu

Online  - Establishes communications with the Controller.  Once communications
are established, the LC software places a check mark next to this menu item.
When the Controller is online, all move commands will be executed by the
machine tool, and the screen will update in real time.

Once the unit goes online, a safety reminder screen appears.  It is imperative that
you and anyone else near the machine understand, agree and adhere to all of the
safety guidelines.  If the safety guidelines are not agreed to, the unit will
immediately go offline.

Offline - Breaks communication with the Controller.  When the Controller is
offline, the LC software places a check mark next to this menu item.  In this
mode, the screen will update, but the machine tool will not move.  This option lets
you “animate” a G-Code file, which is useful for debugging before cutting a part.
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Input Status - Shows the current status of the input lines.  The following dialog
box is displayed:
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Output Control - Allows you to change the state of any output line.  The following
dialog box is displayed:

4 To change the state of an output line

1. Choose On or Off from the Status pull-down menu for a given output
line.  A dialog box will ask if you’re sure you want to turn on or off
the associated device.

2. Choose OK to proceed or Cancel.  Note that the device will turn on or
off immediately after you choose OK.
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View Menu

Scale to Fit - Causes the tool path of the current G-Code File to expand as much
as possible within the Tool Path View Port.  When this option is not chosen, the
Tool Path View Port displays the entire work envelope.

Program, Machine, Relative, Distance To Go, or All Coordinates - Allows you to
choose a display mode for the Tool Position Box.  Choosing either Program
Coordinates, Machine Coordinates, Relative Coordinates, or Distance To Go
Coordinates will expand the chosen coordinate display into the entire Tool
Position Box.  Choosing All Coordinates will display all four coordinate systems
simultaneously in the Tool Position Box. You can also change these view modes
by choosing the expand or contract button next to any of the Coordinate System
Labels.

Help Menu

LC Help - Displays the main help screen.

About LC - Shows the version number of the LC software.

Tool Position Box
The tool position box shows the current tool position in terms of Program,
Machine, Relative and Distance to Go coordinates.
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Program

Displays the coordinates of the current position of the tool relative to Program
Zero.

Machine

Displays the coordinates of the current position of the tool relative to Machine
Zero.  This coordinate system is undefined if Machine Zero has not been set
(displays “N/A”).

Relative

Displays the current relative coordinates.   The relative coordinate system is
general purpose and may be used for anything you choose.  For instance, to
measure the distance from any point in the program without having to use the
Program or Machine coordinates, just zero the relative coordinates at the point
from which you want to measure.

Distance To Go

Displays the distance to the ending position of the current move.

Other Features

Expand Button - Causes the Tool Position Box to show a large display of the
chosen coordinate system.

Expand
Button

Set Button

Coordinate
System Label
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Contract Button - Causes the Tool Position Box to display all four coordinate
systems simultaneously.

Set Button - Sets the X,Y and Z coordinates of the chosen coordinate system to
any value.  When chosen, the following dialog box appears:

4 To set new values within a coordinate system.

1. Type in the X, Y and Z values for each axis.  These coordinates will
become the current position of the tool.

2. Choose OK.

4 

4 To zero each axis.

1. Choose the Zero button for each axis you want to zero.

2. Choose OK.

Contract
Button
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4 To zero all axes.

1. Choose the Zero All button to zero all of the coordinates
simultaneously.

Tool Path View Port
The figure below shows the Tool Path View Port.  The XY Grid represents an
aerial view of the tool envelope.  The Z Scale represents the height of the tool
during machining.  Green and light blue dots are used to represent the origins of
the Program and Machine (if used) coordinate systems respectively.  The Machine
Envelope is shown as the light blue box on the XY Grid and by the light blue bar
on the Z Scale.

The figure below shows the Tool Path View Port during the machining process.
The bottom of the blue tool icon adjacent to the Z scale represents the current Z
position of the tool.  The yellow dot on the XY grid represents the current position
of the tool.  The red outline in the XY Grid represents the tool path of the entire
G-code program.  The red bar along the Z Scale represents the total Z travel.  Blue
represents the portion of the tool path that has already been cut.  Solid lines depict
feedrate moves while dashed lines represent rapid moves.

Z Scale

XY Grid

Program
Zero

Machine
Zero

Machine
Envelope
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Control Box
The Control Box, shown below, contains all of the controls to move the machine
tool.

There are four modes:

G-Code - Moves the tool along the tool path specified by a G-Code
program.

Jog - Provides means to manually move the tool in all three axes.

Point - Moves the tool to any point you specify.

Home - Seeks the home switches for all three axes.

To change modes, simply click on the appropriate mode button.  The operation of
each mode is described below.

Program
Tool Path
(Red)

Rapid Move
(dotted)

Path Already
Cut (Blue)

Current XY
Position
(Yellow)

Current Z
Height

Total Z
Travel
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G-Code Mode

G-Code mode provides controls to move the tool as directed by the current G-
Code program.

Current Tool - Displays the current tool loaded in the machine tool.  Note that
Anaheim Automation’s LC software uses this setting for tool length compensation
(see System Programming for more information).

Feedrate Override Buttons - Increases or decreases the feedrate on the machine as
a percent of the programmed feedrate.  During linear interpolation moves (G01)
you can gradually change the feedrate using the Faster or Slower buttons.  The
Faster and Slower buttons are disabled during circular interpolation and rapid
moves.  When the machine is stopped, you can enter an exact percentage by either
typing a value in the percentage text box or by choosing a value from the pull-
down menu in the percentage text box.  Both the programmed feedrate and the
override feedrate are displayed in the text boxes to the right.  Rapid moves are not
affected by the feedrate override.

You can use the keyboard instead of the Faster/Slower buttons as follows:

Faster Ctrl + Up Arrow Key
Slower Ctrl + Down Arrow Key

Reset Button - Resets the current G-Code file to the first executable line and
refreshes the Tool Path View Port.

Continuous / Step Radio Buttons - You can run the G-Code file in either
Continuous or Step mode by selecting one of these two radio buttons.  In
Continuous mode, the G-Code program runs non-stop.  In Step mode, the G-Code
Program only executes one line at a time. You can switch between step and
continuous modes while the machine is moving.

Start Button - Begins execution of the current line of the G-Code file.  When in
Step mode, execution will stop automatically at the end of the current line, or
when the Feed Hold button is hit.  When in Continuous mode, execution
continues until the end of the program, or until the Feed Hold button is hit.  If the

Continuous /
Step Radio
Buttons

Start Button

Feed Hold
Button

Reset Button

Current Tool

Feedrate
Override
Buttons
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program had been stopped in the middle of a G-Code line, choosing the
Start button will begin execution exactly where the program stopped.
Note that all moves begin with ramping when necessary.

Feed Hold Button - Stops execution of the G-Code file.  Note that once the
Feed Hold button has been hit, the machine tool will always ramp down to
a stop if necessary to avoid loosing steps. For this reason, the slower the
ramp rate, the longer it will take from the time the Feed Hold button is hit
to the time the tool comes to a complete stop.  You can also stop program
execution by hitting any key on the keyboard (except Shift or Ctrl) during
machine operation.

Jog  Mode

Jog mode provides controls for manually positioning the machine tool in all three
axes.

Axis Jog Buttons

You can move a single axis of your machine tool by pressing and holding an Axis
Jog Button.  Ramping is used if the current jog rate is faster than the maximum
unramped feedrate for a given axis.  Note that you can also jog the machine using
the keyboard.  The controls are mapped as follows:

 X+ Ctrl + Right Arrow Key
 X- Ctrl + Left Arrow Key
 Y+ Ctrl + Up Arrow Key
 Y- Ctrl + Down Arrow Key
 Z+ Ctrl + Page Up Key
 Z- Ctrl + Page Down Key

Jog Mode

Single Step - Sets the mode in which the tool will move exactly one motor
step each time an Axis Jog Button is chosen.

Slow - Sets the jog rate to the slow jog rate specified in the
Feedrate/Ramping Setup dialog box.

Axis Jog
Buttons

Jog Mode
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Fast - Sets the jog rate to the fast jog rate specified in the Feedrate/Ramping Setup
dialog box.

Point Mode

Point mode provides controls for moving the tool to the XYZ position you enter at
the feedrate you specify.  In order to avoid tool crashes, all moves with a positive
Z axis element will first move up to the desired Z coordinate and then move to the
desired XY position.  All moves with a negative Z axis element will first move to
the desired XY position and then move down to the desired Z position.

Name - Provides a list of options for where to move:

Any Point - Moves to any XYZ point you enter.

Program Zero - Moves to Program Zero.

Machine Zero - Moves to Machine Zero (if defined).

Tool Change Position - Moves to the Tool Change Position defined in
Machine Coordinates in the Machine Tool Setup dialog box.

Program Start Point – Moves to where the tool was located when the
current G-Code program was started.

Current Line Start Point - Moves to where the tool was located when the
current G-Code line began execution.

Last Hold Point - Moves to where the tool was located when you stopped
G-Code execution using the Feed Hold button.
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Coord - The tool will move to the XYZ position in program coordinates, machine
coordinates, relative coordinates, or incrementally from the current position of the
tool, depending on the option you select in this pull-down menu.

Rate - You can set the feedrate by selecting one of the following from the pull-
down menu:

Rapid - The machine tool moves at the maximum feedrate allowed by
your current maximum feedrate settings in the Feedrate/Ramping Setup
dialog box.

Feedrate - The machine tool moves at the feedrate you enter in the text
box.

Home Mode

Start - Finds the home switch on all three axes.  Homing moves each axis (one at
a time) at a moderate feedrate to ensure that no steps are lost.  To save time, it is
recommended that you first jog each axis near the home switch before homing.
Once Machine Zero (home) is set, the machine tool envelope is redefined.

If Machine Zero was already set before homing, Anaheim Automation’s LC
software displays a dialog showing the discrepancy between the previous
Machine Zero and the new Machine Zero just found.  This provides a convenient
way to check that no steps were lost while cutting a part, within the accuracy
limits of the home switch.  The home switches supplied as an accessory, have a
repeatability of +/-0.001”.
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Clear Machine Zero - Clears the current Machine Zero settings.  This button is
useful when you set Machine Zero manually (using the Zero button in the Tool
Position Box) and need to make a correction to the Machine Zero location.

Message Box
Displays the current status of the Controller and program.  When the Controller
is online, the Message Box and the Offline/Online indicator are Red.

Program Listing Box
The Program Listing box displays the current part program and highlights the
current line. You can use the scroll bar to view the entire program.

Program Listing - A listing of the current part program.

Current Line - The line currently being executed, or about to be executed by the
LC software.

To improve system performance, the Program Listing Box can be configured to
display the current line of G-Code only.  Choose System Options from the Setup
menu to find this setting.

Note that you can open the Editor dialog box by double-clicking the Program
Listing Box.

Offline /
Online
Indicator

Current Line

Program
Listing
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3. Initial Setup
This section describes how to set up the LC for use with your machine tool.  It’s
very important that the software and hardware are set up properly before you
attempt to operate the machine tool.  Otherwise, the machine may behave in a
potentially dangerous manner.  Please read through this section carefully to get a
good understanding of how the LC controls your machine.

Windows Setup
Since Anaheim Automation’s LC software is a real time control program, it must
have full control of the operating system while running.  It is very important that
you do the following before running LC:

Disable all screen savers and power management programs.

Make sure there are no background programs running such as back-up
software and calendar reminders.

Make sure no other programs are open.

4 To Disable the Screen Saver

Windows 95, 98 or NT

1. Choose Settings, then Control Panel from the Start Menu.

2. Double-click the Display icon.

3. Select the Screen Saver tab.

4. Select “(None)” from the Screen Saver pull-down menu.

5. Choose the Apply button.

6. Choose OK to exit.

Windows 3.1

1. Double-click the Control Panel icon in the Main program group.

2. Double-click the Desktop icon.

3. Select “(None)” from the Screen Saver Name pull-down menu.

4. Choose OK to exit.

Section
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Software Setup

The Setup File

All software settings are stored in a “setup” file, which by default has a “.STP”
extension.  Before you start, you’ll need to open the appropriate setup file.
Choose Open Setup from the File menu and select the appropriate setup file.
Some setup files are supplied for various mills and lathes.  If a setup file is not
available for your machine, select LCXXX.STP, where “XXX” is the current
software version (eg. “LC121.STP” for version 1.21).  Note that LCXXX.STP
is based on the Sherline 5400, but is easily modified to accommodate any
machine tool.

Once you’ve opened the setup file, choose Save Setup As and follow the dialog
boxes to save the setup file under a new name or directory.  This lets you go back
to the original setup file if necessary.  Using this method you can create a unique
setup file for each of your machine tools.

The last setup file used will automatically be loaded the next time you run
Anaheim Automation’s LC software.

System Settings

4 To set your system settings

1. Choose System Options from the Setup menu.  The System Options
dialog box will appear.

2. Determine which serial port you will use to communicate with the
Controller.  Typically, this is either COM1, COM 2, COM 3, or
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COM 4 depending on how many serial ports and serial devices you have, such
as a modem.  Once you determine the serial port, choose it from the Serial
Port pull-down menu.

3. The Baud Rate is the speed at which the LC communicates across the serial
port with the Controller.  It is measured in bits per second.  This is typically
set at 38,400.  For older PC’s exhibiting serial communications problems, set
this to a lower speed.  For most applications, LC will perform the same at
baud rates of 19,200, 38,400 and 57,600.  If you change this setting, you must
reset the baud rate on the Controller by going Offline and Online from the
Controller menu.  If there are communication problems, you must turn the
Controller off and on before going back online.

4. The Buffer Time is used to prevent system events (such as screen updates)
from affecting motor movement on the machine tool.  The larger the Buffer
Time, the less effect system events have on motor movement.  The smaller the
Buffer Time, the more responsive the machine tool is to mouse clicks and
keyboard commands.  In most cases, the lag-time between the PC and the
motor movement is imperceptible.  The value can range from 0.01 to 1.0
seconds.  Slower computers may require a higher value.  If you want to
change this setting, enter a new value in the Buffer Time text box.

5. The Start Delay allows the screen to fully update after the Start button or Jog
button is selected and before your machine tool begins moving.  There are
separate values for Jog moves and G-Code or Point moves.  Slower computers
may require a higher value.  If you want to change these settings, enter a new
value in the appropriate text box.

6. The Coordinate Update value determines how often the coordinates are
updated in the Tool Position Box while the tool is moving.  There are separate
values for Jog moves and G-Code or Point moves.  Higher values may
increase performance on slower computers.  If you want to change these
settings, enter a new value in the text box.  Note that coordinates are always
updated at the end of every move.

7. The size of the Program Listing Box affects system performance during a
continuous run.  To see the entire Program Listing Box during a continuous
run, select the Show Program Listing Box radio button.  For better
performance, select the Show Current G-Code Line Only radio button.  This is
especially important when you’re running programs with a large number of
very short moves.

8. LC Series can easily be configured for the type of machine that you are
running.  Choose either Mill or Lathe from the Type pull-down menu.  If you
are using a machine with CNC control on the X and Y axes only, remove the
check from the Z Axis check box.

9. The Controller model you have affects the way in which the limit switches
should be wired.  Choose the appropriate model number from the pull-down
menu.  If you have Model 401A the limit switches should be wired normally
closed.  If you have Model 401 the limit switches should be wired normally
open.
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10. The LC software can be set up in either English (inch) or Metric (mm)
mode.  Choose the appropriate system from the Display Units pull-down
menu.

11. The G-Code File Extension text box makes opening G-Code programs
more convenient.  If you normally open files made by the DXF import, set
this to “AGC”.  If you normally open files made by another CAM
program, type in its file extension (such as “NC”).

12. Set the G-Code Filter pull-down menu to “All Files” if you normally open
files with a variety of extensions.  If you normally use the extension you
defined above, then set the G-Code filter to that extension.

Machine Tool Settings

4 To set the Machine Tool Settings

1. Choose Machine Tool from the Setup Menu.  The Machine Tool Setup
dialog box will appear.

2. The Tool Positioning Resolution for each axis (inches of axis movement
per motor step) is automatically calculated for you using four factors.
Determine the values for each of these factors and enter them in the
corresponding text box.

3. Step Mode - The number of mini, or micro steps between each motor
step.  Note that this is a characteristic of the Stepper Motor Driver and
cannot be changed without servicing the driver.  Enter “1” for full-step,
“2” for half-step, “4” for quarter-step, and so on.

4. Motor Resolution - The number of full motor steps for one revolution of
the motor.  For example, a 1.8° stepper motor will have 200 full steps per
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revolution, a 0.9° Stepper Motor will have 400 full steps per revolution,
and so on.  This number is a characteristic of the stepper motor and is
independent of the Stepper Motor Driver or the Step Mode.

5. Gear Ratio - The ratio of the number of stepper motor revolutions to
drive screw revolutions due to any gears or pulleys between them.  If it is
a direct drive, enter 1 in this box.

6. Screw Thread - The number of turns per inch of the helical drive screw
for each axis.   For example, a single threaded, 0.05” pitch screw would
have 20 turns per inch.

7. There are also general settings unique to each machine tool.  These are
described below.  Once you determine the correct value for each general
setting, enter it in the appropriate text box.

8. Axis Length - Sets the length of travel of each axis of your machine tool.
You may want to define the axis length slightly smaller than the values
published by the machine tool manufacturer.  This will leave some room
for error.  Enter these figures in the Axis Length  text boxes.

9. Motor Polarity - Depending on how a motor is wired, the same signal
from the Stepper Motor Driver can turn it clockwise or counter clockwise.
Use the jog buttons to make sure that a positive move in each axis on the
screen corresponds to a positive move in each axis on the machine tool.
Note that the direction of movement is defined as the direction of the tool
relative to the table.  For example, a positive X move in the program (tool
movement to the right) will result in table movement to the left.  If any
direction is incorrect, change the motor polarity from Positive to Negative
(or vice-versa) to reverse the correspondence between the software and
machine tool.

10. Machine Envelope Home End - The end of an axis at which the optional
home switch is installed.  This determines the placement of the origin of
the Machine Tool Envelope (Machine Zero) once home is set.

11. Home Switch Offset - The distance each axis backs away from the home
switch after the switch is closed during homing.

12. Backlash - Sets the amount of backlash for each axis.  See the “Setting
Backlash” section below for more information.

13. Comp – Tells LC whether or not to use backlash compensation for all
direction changes.  Leave this checkbox unchecked for now.  It is
discussed in the “Setting Backlash” section below.

14. Tool Change Position – The position in Machine Coordinates where the
machine will move when given the G28 command in the program.

15. When you are done entering the correct information, choose the OK
button.
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Feedrate and Ramping Settings

Every machine tool will vary as to how fast it can move each axis without losing
steps.  Losing steps means that even though the stepper motor gets the signal to
move a step, it isn’t able to move the step, and accuracy is lost.  The usual cause
is insufficient drive torque at a given motor RPM.  Since most stepper motors are
“open loop” systems,  there is no way of telling when a step is lost without
physically measuring the movement of the axis and comparing that to the amount
it should have moved.  However, when not “over torqued”, a stepper motor is
very reliable and accurate.  For that reason, we highly recommend finding the
maximum rates at which steps are not lost, both with and without ramping, and
then limiting the maximum rates for each axis to about 70% of those values.  Due
to variations in the drive mechanism for each axis, make sure you do the
following tests in all directions, and at several positions along each axis.

4 To Set the Maximum Unramped Feedrates

1. Choose Feedrate/Ramping from the Setup Menu.  The Feedrate/Ramping
setup dialog box will appear.

2. Enter 99 for the X axis Max Unramped Feedrate, and 100 for the
Maximum Feedrate, then choose OK.

3. Choose the Point button on the Control Box.  Select Any Point from the
Name pull-down menu and Incremental from the Coord pull-down menu.
Enter 1.0 in the X text box and enter a relatively slow feedrate (such as 5).
Make sure you have room to move the X axis 1 inch, then choose Start.

4. If the motor slips, repeat this process with a slower feedrate.  If the motor
doesn’t slip, try a faster feedrate. Repeat this process until you find the
highest feedrate that doesn’t cause motor slippage.

5. Now run the entire length of the axis in both directions to make sure there
is no slippage at any point on the entire axis.

6. Choose Feedrate/Ramping from the Setup Menu.
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7. Enter 70% of the value you found in the Max Unramped Feedrate text box
for the X axis, then choose OK.

8. Repeat this process for all axes.

4 To Set the Maximum Feedrates

After finding the maximum unramped feedrates, you’re ready to find the
maximum feedrates achievable with ramping.

1. Choose Feedrate/Ramping from the Setup Menu.  The Feedrate/Ramping
Setup dialog box will appear.

2. Enter 10,000 full steps/sec/sec in the Ramping Rate text box for the X
axis. (This is an average ramping rate.)

3. Leave the Max Unramped Feedrates at the values you found earlier.
Leave the Maximum Feedrates at the very high number (100 in/min) and
choose OK.

4. Choose the Point button on the Control Box.  Select Any Point from the
Name pull-down menu and Incremental from the Coord pull-down menu.
Enter 1.0 in the X text box and enter a feedrate that is about 50% higher
than the Max Unramped Feedrate for the X axis.  Make sure you have
room to move the X axis 1 inch, then choose Start.

5. If the motor slips, repeat this process with a slower feedrate.  If the motor
doesn’t slip, try a faster feedrate.  Note that slight slippage can be detected
by reading the values on the table feed hand-wheel.

6. Repeat this process you find the highest feedrate that doesn’t cause motor
slippage.

7. Now run the entire length of each the X in both directions to make sure
there is no slippage at any point on the entire axis.

8. Choose Feedrate/Ramping from the Setup Menu.

9. Enter 70% of the highest no-slip feedrate you found in the X axis
Maximum Feedrate text box.

10. Repeat this process for all axes.

4 To Set the Ramping Rate

Ramping Rates typically range from 1000 to 100000 full steps/sec/sec.
Slower ramping rates require more time to ramp up to the maximum feedrate
and to ramp down to a stop.  This may become a potentially dangerous
situation when using the Feed Hold button or jogging since the machine will
take longer to come to a complete stop.  The goal is to choose a fast ramping
rate that will start and stop the tool responsively without losing steps.  Fast
ramping rates can also allow acceleration past resonant speeds of the stepper
motor.
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1. Choose Feedrate/Ramping from the Setup Menu. The Feedrate/Ramping
Setup dialog box will appear.

2. Enter 10,000 full steps/sec/sec in the Ramping Rate text box for the X
axis. (This is an average ramping rate.)

3. Leave the Max Unramped Feedrates and Maximum Feedrates at the values
you found earlier and choose OK.

4. Choose the Point button on the Control Box.  Select Any Point from the
Name pull-down menu and Incremental from the Coord pull-down menu.
Enter 1.0 in the X text box and choose the Rapid option from the Rate
pull-down menu.  Make sure you have room to move the X axis 1 inch,
then choose Start.  If the table moves at the Max Unramped Feedrate
instead of the Maximum Feedrate, there isn’t enough room to ramp and
you should increase the distance moved.

5. If the motor slips, repeat this process with a lower Ramping Rate.  If the
motor doesn’t slip, try a higher Ramping Rate.

6. Repeat the above steps until you determine an optimal ramp rate for the X
axis.

7. Choose Feedrate/Ramping from the Setup Menu.

8. Enter 70% of the highest no-slip ramping rate you found in the X axis
Ramping Rate text box.

9. Repeat this process for all axes.

10. Note that once the optimal ramp rate is determined for each axis, you may
want to re-test the Maximum Feedrates to see if they can be set any
higher.

4 To Set the Direction Change Delay

The direction change delay is a brief pause that occurs when a motor changes
direction.  It gives the stepper motor time to settle down and come to a
complete rest before moving in the opposite direction.  Note that the direction
change delay is not used when a motor changes direction during circular
interpolation.

1. Write a G-Code file that goes back and forth in a given axis at the
maximum unramped feedrate.  For example, if the maximum unramped
feedrate were 8:

G01 X2 F8

X0

X2

X0

2. Set the Direction Change Delay to 0.5 seconds for the given axis.
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3. Run the program and notice if the motor loses steps.  If so, increase the
Direction Change Delay.  Otherwise decrease the number.

4. Repeat the above process until you reach a reasonable delay time that
eliminates any motor slippage.  Note that this number is typically between
0.05 and 0.3 seconds.   If you do not see any slippage at a delay of 0
seconds, it is recommended you enter at least 0.05 seconds.

5. Repeat the above process for all axes.

4 To Set the Jog Rates

1. Choose Feedrate/Ramping from the Setup Menu.

2. Fill in both the Slow Jog Rate and the Fast Jog Rate text boxes.  Choose a
Slow Jog Rate that will allow fine positioning of the machine tool
(typically about 2-5 in/min).  Choose a Fast Jog Rate that will move the
tool quickly, yet allow you to remain in complete control without creating
a dangerous situation.  Remember that the CNC machine cannot jog any
faster than the maximum feedrate for each axis.

4 To Set the Maximum Arc Feedrate

Due to the computations involved during circular interpolations, an arc cannot
be executed as fast as a line.  For this reason, there is a user-settable limitation
for the maximum arc feedrate.

3. Write a G-Code program that cuts a circle at the maximum feedrate.  For
example, if the maximum feedrate were 25:

G00 X2 Y2

G02 X2 Y2 I1 J1 F25

4. Run the program and notice if either the X or Y motors lose steps.  If so,
decrease the feedrate in the program.

5. Repeat the above process until neither motor loses any steps.  When you
are done, enter the final feedrate from the program into the Maximum Arc
Feedrate text box.  If there was no loss of steps when the Maximum
Feedrate was used, enter the Maximum Feedrate into the text box.

Setting Machine Zero

Setting Machine Zero using home switches not only sets up the machine tool
envelope, but also allows you to re-position a tool to a precise physical location
even after the controller has been turned off or has lost power.

Setting Machine Zero without home switches won’t help you reposition a tool
after losing power, but it will set the machine tool envelope.  This is very useful
because the software will always ramp down the machine to a complete stop at
the defined limits of the machine tool envelope.
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4 To Set Machine Zero Using Home Switches

1. Choose Machine Tool from the Setup Menu.  The Machine Tool Setup
dialog box will appear.

2. Make sure you’ve entered correctly the home switch setup parameters as
described in the Machine Tool Settings section of this manual.  Choose
OK.

3. Choose the Home button on the Control Box.

4. Choose the Start button.  The machine will now move each axis until it
finds the home switch.  If you need to stop the process for any reason,
choose the Feed Hold button, or hit any key on the keyboard besides Ctrl
or Shift.

5. If Machine Zero was already set before homing, the LC software displays
a dialog showing the discrepancy between the previous Machine Zero and
the new Machine Zero just found.  Choose Yes if you want to use the new
Machine Zero just found, or No if you want to keep the existing Machine
Zero.

6. If you chose Yes, the Machine Coordinates will automatically zero.  The
Machine Tool Envelope will appear in the Tool Path View Port.

4 To Set Machine Zero Without Using Home Switches

1. Choose Machine Tool from the Setup Menu.  The Machine Tool Setup
screen will appear.

2. Make sure you’ve entered correctly the home switch setup parameters as
described in the Machine Tool Settings section of this manual.  Choose
OK.

3. Choose the Jog button on the Control Box.

4. Jog the tool to the home end of each axis as defined in the Machine
Envelope Home End column in the Machine Tool Setup screen.  Move
each axis to within a short distance of its physical limit.

5. If this is the first time you’re setting Machine Zero, it might be helpful to
scratch a reference line or affix a vernier scale between the two relative
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moving parts on each axis.  This will help you “eye-ball” the same home
position again.

6. Choose the Set button next to the “Machine” label in the Tool Position
Box.  Then choose the Zero All button in the Set Machine Coordinates
dialog box.

7. If Machine Zero was already set, the LC software displays a dialog
showing the discrepancy between the previous Machine Zero and the new
Machine Zero just set.  Choose Yes if you want to use the new Machine
Zero just set, or No if you want to keep the existing Machine Zero.

8. If you chose Yes, the Machine Coordinates will automatically zero.  The
Machine Tool Envelope will appear in the Tool Path View Port.

Setting Backlash

If you do not have ball-screws or any other “zero backlash” scheme on your
machine, the software can compensate for the backlash.  Of course, you are
always best off removing as much backlash from the mechanical system as
possible in addition to using the software backlash compensation.

4 To Set Backlash

1. Choose Machine Tool from the Setup Menu.  The Machine Tool Setup
screen will appear.

2. Make sure the Comp checkbox is unchecked, then choose OK.

3. Choose the Jog button on the Control Box.

4. Drive the X axis in one direction at least 0.25”  (this will take out any
backlash in that direction).

5. Zero the Relative Coordinates by choosing the Set button next to the
“Relative” label, then Zero All.

6. Choose the Single Step radio button.  Jog the axis step by step in the
opposite direction until you detect table movement (using a dial indicator).

7. The Relative Coordinate X axis value is the amount of X axis backlash on
your machine tool.

8. Write down this number and repeat the above process at different places
along the X axis.

9. Choose Machine Tool from the Setup menu.  The Machine Tool Setup
dialog box will appear.

10. Record the average of all backlash values in the X axis Backlash text box.
If you have no backlash on an axis, or if you don’t want backlash
compensation on an axis, just enter zero.

11. Repeat the above steps for each axis.  When you’re finished, choose the
Comp checkbox and make sure there is a check in it.
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Tooling Settings

Anaheim Automation’s LC software provides for a tool library of up to 100 tools.
Each tool has an associated tool number, description and length offset.  The
length offset is used when tool length compensation (G43 or G44) is used in a G-
Code program.

4 To Set Up the Tool Library

1. Choose Tooling from the Setup menu.  The Tooling Setup dialog box will
appear.

2. Enter the tool description for each tool next to the appropriate tool
number.  The program will use this description when referring to a given
tool.

3. Enter the length of the tool relative to a common reference point.  For
example, if there is a locating feature on an endmill holder that can be
used to maintain a repeatable location between the endmill holder and the
spindle, use the axial distance between the tip of the tool and the locating
feature of the end mill holder as the tool length offset.  Note that this
method assumes each tool has its own end mill holder.

4. Repeat the above for each tool in your library.
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Input Line Settings

Anaheim Automation’s LC software can test up to 8 input lines wired to
limit/home switches or general safety switches (such as a door switch on a safety
enclosure).  You can use all 8 input lines however you choose, but all must be
wired the same, either all normally open or all normally closed.  If controller you
are using is a model 401 then it is best if all input lines are normally open (N.O.).
If your controller is model 401A, then it is best if all input lines are normally
closed (N.C.).  Make sure that the controller model is properly selected in the
System Options dialog box.  Please see the LC Hardware Guide for more
hardware details including the pin layout of the input line connector.

When the LC software detects a tripped input line, it immediately stops all tool
movement (without ramping). The accuracy of the tool position will most likely
be lost at that point.  If a limit switch has been tripped, the LC software will only
allow you to jog away from the switch that was tripped.  Once you move the table
off the limit switch, normal operation will resume.  If a safety switch is tripped,
the LC software will not allow any machine movement until you clear the switch.

4 To Configure the Input Lines

1. Choose Input Lines from the Setup menu.  The Input Lines Setup dialog
box will appear.

2. For input line 1, choose the appropriate option from the Switch Function
pull-down menu.  For example, if the line is wired to a limit switch on the
negative end of the X axis, choose X-.  If the line is wired to a general-
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purpose safety switch, choose Safety and enter a Description.  If the line is
unused, choose Unused.  (Note: The “Control” option is not used by the
current version of the LC controller.)

3. Repeat for all 8 input lines.

Output Line Settings

Anaheim Automation’s LC software can control up to 8 output lines to activate
devices such as the spindle or coolant pump.  You can manipulate any or all of the
output lines with user defined M codes.  Please see the LC Hardware Guide for
more hardware details including the pin layout of the output line connector.

4 To Configure the Output Lines

1. Choose Output Lines from the Setup menu.  The Output Lines Setup
dialog box will appear.

2. In the Description text boxes, type descriptions for each device connected
to the output lines.

4 To define an M-code to control output lines

1. In the M Code text box type the number for the M-code that you want to
define.

2. In the Description text box type a phrase which best describes the action
taken when this M-code is executed.

3. In the Output Line Action pull-down menus, choose the action for each
line upon execution of the M-code.  The choices are On, Off, or “–“,
where the “-“ indicates that the state of the line remains unchanged.
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4. Choose Before or After from the Before/After Move pull-down menu.  If
you choose Before and there is a machine tool move command on the
same program line as the M-Code, the M-code will be executed before the
move.  If you chose After, the M-code will be executed after the move.

5. In the Delay text box, enter the amount of delay between execution of the
M-Code and execution of the next G-Code command.  For example, if
your spindle motor takes about 3 seconds to get to full speed, this value
should be at least 3.  For safety reasons, the maximum value for this delay
is 5 seconds.

Motor Signal Settings

Anaheim Automation’s LC software provides four signals for step motor drivers:
step, direction, park and enable.  Different manufacturers have different
requirements for the polarity and timing of these signals.  The LC software
provides the flexibility to tailor the motor signals to run most drivers.

4 To Configure the Motor Signal Lines

1. Choose Motor Signals from the Setup menu.  The Motor Signals Setup
dialog box will appear.

2. From the Step Pulse pull-down menu choose either High or Low
depending on the polarity of the step pulse.  See the diagram below.
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Low Step Pulse

High Step Pulse

Step Pulse Width

+5 V

0 V

+5 V

0 V

3. In the Step Pulse Width text box, type the duration of the step pulse in
microseconds.

4. From the Enable Signal pull-down menu, choose High if the driver is
enabled by a high signal, or Low if the driver is enabled by a low signal.

5. From the Park Signal pull-down menu, choose High if a high signal to the
park (low power) line puts the driver into a reduced power mode.  Choose
Low if the opposite is true.  Note that most motor drivers do not have a
separate line to control the power level.  In this case the setting for this
line will not be applicable.

6. Note that the direction polarity is set by the Motor Polarity field in the
Machine Tool Setup dialog box.

Recommended Settings for Various Stepper Motor Driver Boxes:

Function Operational State

Step Pulse Low

Step Pulse Width 15

Enable Signal High

Park Signal Not Used (Low or High)

G and M Code Settings

The LC software lets you customize handling of some G and M codes.

4 To Configure G and M Code Handling

1. Choose G/M Codes from the Setup menu.  The G/M Code Setup dialog
box will appear.
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2. Check the Ignore G54 checkbox if you want the LC to ignore this
command in a G-Code program.  The LC does not currently support G54.
If you choose to ignore G54, make certain any G-Code program you run
does not rely on G54 to position the machine tool.

3. Check the Message on M00 Program Pause checkbox if you want the LC
to display a message dialog whenever it encounters an M00 command in a
G-Code program.  If you uncheck this option, LC will pause processing of
the G-Code program without displaying a message.
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4. System Programming
Anaheim Automation’s LC software reads a subset of ANSI standard G-Code to
control machine tool movement.  This section describes how to bring a G-Code
file into the LC, the G-Codes supported, and a brief explanation of their use.

There are three ways you can bring G-Code files into the LC:

• Open an existing G-Code file created by a CAM program, LC or any
other source.

• Import a DXF file created by a CAD or drawing program.

• Write a G-Code program directly in the LC editor.

Opening a G-Code Program

4 To open an existing program

1. Choose Open G-Code from the File menu.  The Open G-Code File dialog
box appears.

2. In the “List files of type” pull-down menu, choose the type of file you are
looking for.  Existing LC files will have an “.AGC” extension.  If you are
unsure of the file type, choose “All Files (*.*).”

3. In the Drives pull-down menu choose the drive that contains the file.

4. In the Folders list box, double-click the name of the folder that contains
the file.  Continue double-clicking subfolders until you open the subfolder
that contains the file.

5. In the box that lists files, double-click the file name, or click on the file
name and choose OK.

Importing a DXF File
The LC software provides a very useful 2D DXF import feature.  The DXF
import automatically arranges all lines and circles that have common endpoints
into features.  The entire toolpath is then optimized to reduce total machining time
for the part.  The DXF import assumes the part surface is at a Z program height of
0.0 and all geometry is to be treated as either holes or cutter paths with no offsets.

4 To import a DXF file

1. Choose Import DXF from the File menu.  The Import DXF File dialog box
appears.

2. In the “List files of type” pull-down menu, choose the type of file you are
looking for.  A DXF file should have a “.DXF” extension.

Section
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3. In the Drives pull-down menu choose the drive that contains the file.

4. In Folders list box, double-click the name of the folder that contains the
file.  Continue double-clicking subfolders until you open the subfolder that
contains the file.

5. In the box that lists files, double-click the file name, or click on the file
name and choose OK.

6. The Save G-Code File dialog box appears asking you the name of the new
G-Code file created by the DXF import.  By default, it will use the DXF
file name with an “.AGC” extension in the same drive and folder in which
the DXF file resides.  If this is acceptable, choose OK.

4 To choose a different file name or folder

1. Choose the drive you want from the Drives pull-down menu.

2. Click on the folder you want in the Folder box.

3. Type the file name in the File name box, or type the entire path in the File
name box.

4. Choose OK.

5. The Import Setup dialog box will appear.

6. Fill in the values for each of the following fields:

7. Scale - A multiplication factor for the toolpath in the XY plane only. For
example, if you enter a 2 here, the toolpath generated will be double the
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size of the original geometry defined in the DXF file.  Note that the values
you enter for positioning the Z axis are unaffected by the scale factor.

8. Decimals - The number of decimal places to use for all coordinates.  A
higher number can help eliminate extra backlash compensation moves
caused by rounding error.

9. Join Tolerance – If two drawing entities, such as two lines, are touching
end to end, LC treats them as a single feature to machine without lifting
the tool.  Due to rounding or drawing error, two entities that are meant to
be joined may not actually touch end to end.  The DXF import will
automatically join any entities whose endpoints are less than the Join
Tolerance apart.

10. Line Numbers – Check this box if you want the DXF import to number all
of the G-Code lines in the program it creates.

11. Incremental Depth of Cut - The incremental depth for each milling pass.
For example if the final tool down is -0.2500” and the incremental depth
of cut is 0.0625” then four passes would be cut on each feature to get to
the final depth of cut.  (-0.0625, -0.1250, -0.1875, -0.2500).  If the final
tool down is -0.3000” and the incremental depth of cut is 0.0625” then
five passes would be cut on each feature to get to the final depth of cut (-
0.0625, -0.1250, -0.1875, -0.2500, -0.3000).

12. Tool Up - The height (program coordinates) to which the tool will move
before rapid moves between two features.

13. Final Tool Down (Milling) - The final depth (program coordinates) to
which the tool will cut each feature.

14. Final Tool Down (Holes) - The final depth (program coordinates) to which
the tool will cut each hole.

15. Program Zero Location

16. X, Y of Import File - The X and Y location in the DXF file that LC will
place at the program origin in the G-Code file.

17. Lower Left of Toolpath - Defines program zero as the lower left point of
the imaginary box that envelopes all geometry contained in the DXF file.

18. Circles - Defines diameters for circles that will be drilled (at the center
point) instead of milled along the perimeter.

19. XY Feedrate - The feedrate for all milling operations in the XY plane.

20. Plunge Feedrate - The feedrate for all downward Z axis moves.

21. Choose OK.

22. The G-Code will appear in the Program Listing Box and the tool path will
appear in the Tool Path View Port.
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Using the Program Editor
The LC software provides a handy editor for creating or modifying G-Code
Programs.  If you need a more feature-rich editor for your programming, you can
also use your own editor such as WordPad (which comes standard with Windows
95), or Microsoft Word, etc.  If you do use a different editor make sure you save
the file as Text Only and use an “.AGC” extension on the file name.

4 To open the editor

1. Choose Editor from the File menu, or double-click the Program Listing
Box. The editor dialog box will appear.

2. You can type or edit your program in the scrolling text box.  Refer to the
“G and M Code Reference” section below to learn more about using G-
Code.

4 To edit a new program

1. Choose New Program from the editor’s File menu.

4 To open an existing program
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1. Choose Open G-Code from the editor’s File menu.  The Open G-Code
File dialog box appears.

2. In the “List files of type” pull-down menu, choose the type of file you are
looking for.  Existing LC files will have an “.AGC” extension.  If you are
unsure of the file type, choose “All Files (*.*).”

3. In the Drives pull-down menu choose the drive that contains the file.

4. In Folders list box, double-click the name of the folder that contains the
file.  Continue double-clicking subfolders until you open the subfolder that
contains the file.

5. In the box that lists files, double-click the file name, or click on the file
name and choose OK.

4 To see your new tool path updated in the Tool Path View Port without
leaving the editor

1. Choose Update Tool Path.

4 To save your program using the same file name

1. Choose Save G-Code from the editor’s File menu.

2. If you’re saving a new file, a Save G-Code File dialog box will appear.
Follow the directions “To save a new program…” below starting with step
2.

4 To save a new program created by the editor, or to save an edited file
under a different file name

1. Choose Save G-Code As from the editor’s File menu.

2. Choose the drive you want from the Drives pull-down menu.

3. Click on the folder you want in the Folder box.

4. Type the file name in the File name box, or type the entire path in the File
name box.

5. Choose OK.

4 To close the editor

1. Choose Exit.
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G and M Codes Supported
G00 Rapid Tool Positioning

G01 Linear Interpolated Cutting Move

G02 Clockwise Circular Cutting Move (XY Plane)

G03 Counter Clockwise Circular Cutting Move (XY Plane)

G04 Dwell

G17 XY Plane Selection

G18 XZ Plane Selection

G19 YZ Plane Selection

G20 Inch Units (same as G70)

G21 Metric Units (same as G71)

G28 Return to Reference Point

G29 Return from Reference Point

G43 Tool Length Compensation (Plus)

G44 Tool Length Compensation (Minus)

G49 Cancel Tool Length Compensation

G52 Use Local Coordinate System

G70 Inch Units (same as G20)

G71 Metric Units (same as G21)

G90 Absolute Positioning Mode

G91 Incremental Positioning Mode

M00  Program Pause

M02 End of Program

M06 Tool Change

MXX Custom Programmable (See “Output Line Settings” in the Software Setup
section of this manual)

M30 End of Program (Reset)

M98 Subroutine Call

M99 Return From Subroutine

F Feedrate

( ) Comment

Key Programming Concepts
There are two basic programming concepts you should understand before learning
the G and M codes – Mode and Absolute vs. Incremental.
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Mode

Most G-code commands supported by LC are modal, meaning they put the
system into a particular mode of operation and need not be repeated on every
program line.  A modal command stays in effect until another command changes
the mode.  Related modal commands that affect one aspect of program execution
are called a mode group.

The following list shows the mode groups for G-code commands supported by
LC.

Move Mode

G00 Rapid Tool Positioning

G01 Linear Interpolated Cutting Move

G02 Clockwise Circular Cutting Move

G03 Counter Clockwise Circular Cutting Move

Circular Interpolation

G17 XY Plane Selection

G18 XZ Plane Selection

G19 YZ Plane Selection

Units

G20 Inch Units (also G70)

G21 Metric Units (also G71)

Tool Length Compensation

G43 Tool Length Compensation (Plus)

G44 Tool Length Compensation (Minus)

G49 Cancel Tool Length Compensation

Positioning Mode

G90 Absolute Positioning Mode

G91 Incremental Positioning Mode

Miscellaneous  Modes using Single Command

G52 Use Local Coordinate System

F      Feedrate

Absolute vs. Incremental

All moves are either absolute or incremental.  In an absolute move, the ending
point is defined relative to a coordinate system origin, usually Program Zero.  In
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an incremental move, the ending point is defined relative to the current tool
location.  The G90/G91 commands tell the system which of these two modes to
use (described below).

While there will be cases where incremental programming is useful, generally you
should define your moves as absolute since it is a less error prone method of
programming.  All of the examples in the following section use absolute
positioning unless otherwise noted.

G and M Code Reference

G00 Rapid Tool Positioning

The G00 command moves the tool to the designated XYZ coordinate at the rapid
rate using 3-Axis linear interpolation.  The rapid rate is calculated from the
Maximum Feedrates defined in the Feedrate/Ramping Setup dialog box.

Example:

G00 X1.0 Y2.0 Z1.5 Moves the tool directly to the Program
Coordinate X=1.0, Y=2.0, Z=1.5 at the rapid
rate (assuming G90 is active).  If G91 is
active then it moves the tool a distance 1, 2,
1.5 from the current location.

When using G00, there are several things to keep in mind:

• You do not need to specify all three coordinates, only the ones for
which you want movement.

Example:

G00 X4.0 Y3.0 Moves the tool to Program
coordinate X=4.0, Y=3.0, leaving the
Z position unchanged.

• This is a modal command, meaning that all successive moves will be
treated as rapid moves until another modal move command (G01, G02
or G03) occurs.

Example: 

G00 X1.0 Y2.0 Z1.5 Rapid Move

X4.0 Y6.5 Z1.0 Rapid Move

G01 X3.0 Y3.0 Z1.4 Feedrate Move

X2.8 Y1.4 Z0 Feedrate Move

• The interpretation of the coordinates depends on the G90/G91
command in effect.
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G01 Linear Interpolated Cutting Move

The G01 command moves the tool to the designated XYZ Program coordinate at
the designated feedrate using 3-Axis linear interpolation.

Example:

G01 X2.0 Y1.0 Z-1.5 F2.0 Moves the tool directly to the Program
coordinate X=2.0, Y=1.0, Z=-1.5 at a
feedrate of 2.0 in/min.

You do not need to specify all three coordinates, only the ones for which you
want movement.

Example:

G01 X4.0 Y3.0 Moves the tool to Program coordinate
X=4.0, Y=3.0, leaving the Z position
unchanged.

When using G01, there are several things to keep in mind:

• As explained for the G00 Command, X,Y, and Z are not required.

• The command is modal, i.e. G01 is in effect until another move
command occurs (G00, G02, or G03).

• The interpretation of the coordinates depends on the G90/G91
command in effect.

• The F command is used to designate a feedrate.  The feedrate set with
the F command is modal (stays in effect until another F command
occurs).

Example:

G01 X4.0 Y3.0 Z1.0 F7.0 Moves the tool to Program coordinate
X=4.0, Y=3.0, Z=1.0 at a feedrate of 7.0
in/min.

X2.0 Y2.5 Moves the tool to Program Coordinate
X=2.0 Y=2.5, leaving the Z axis unchanged
at Z=1.0.  The feedrate remains 7.0 in/min.

G02 Clockwise Circular Cutting Move

The G02 command moves the tool in a clockwise path from the starting point (the
current tool position) to the designated ending point in the currently selected plane
(see G17-G19).  The I , J, and K parameters represent the relative X, Y, and Z
distances (respectively) from the starting point of the arc to the center point of the
arc.

Example:
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G01  X1.0 Y1.0 F3.0 Moves the tool directly to the Program
Coordinates X=1.0, Y=1.0 at a feedrate of
3.0 in/min.

G02  X3.0 Y3.0 I1.0 J1.0 Moves the tool using clockwise circular
interpolation to the Program Coordinates
X=3.0, Y=3.0 with a center point of X=2.0,
Y=2.0 at a feedrate of 3.0 in/min.

1,1 Start

2,2 Center

3,3 End

I=
1, J

=1

When using G02, there are several things to keep in mind:

• The command is modal, i.e. G02 is in effect until another move
command occurs (G00, G01, or G03).

• The interpretation of the X, Y and Z coordinates depends on the
G90/G91 command in effect.  The I, J and K values are unaffected by
G90/G91.

• The tool will move at the current feedrate set by the last F command.

• Only XY arcs can be cut when G17 is active, only XZ arcs can be cut
when G18 is active and only YZ arcs can be cut when G19 is active.

• The clockwise direction of rotation is as viewed from the positive end
of the unused axis (the axis not in the plane of motion).  For example,
a G02 arc move in the XY plane is clockwise as viewed from the
positive end of the Z axis (i.e. from above).  The following diagram
illustrates this behavior:
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+X

+Y

G02 Clockwise

+X

+Z

G02 Clockwise

+Y

+Z

G02 Clockwise

G03 Counter Clockwise Circular Cutting Move

The G03 command is identical to the G02 command, but it moves the tool in a
counter clockwise arc instead of a clockwise arc.

Example:

G01  X2.0 Y1.0 F8.0 Moves the tool directly to the Program
Coordinates X=2.0, Y=1.0 at a feedrate of
8.0 in/min.

G03  X0.0 Y3.0 I-1.0 J1.0 Moves the tool using counter-clockwise
circular interpolation to the Program
Coordinates X=0.0, Y=3.0 with a center
point of X=1.0, Y=2.0 at a feedrate of 8.0
in/min.

2,1 Start

1,2 Center

0,3 End
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G04 Dwell

The G04 command causes the program to dwell or wait for a specified amount of
time.  The time to wait is specified by the letter “X” immediately followed by the
number of seconds.  For safety reasons there is a maximum time allowed for each
dwell command.

Example:

G04 X1.5 The program pauses for 1.5 seconds before
moving on to the next line of G-Code.

 G17, G18, G19 Arc Plane Selection

These commands specify the plane used for circular interpolation as follows:

G17 XY plane

G18 XZ plane

G19 YZ plane

When using G17-G19, there are several things to keep in mind:

• Unless you explicitly use the G18 or G19 command, LC assumes G17
as the default.

• The three commands are modal, i.e. one command remains in effect
until another in the set is used.

G20, G21 Inch Units and Metric Units

The G20 command indicates that all G-Code commands are in inch units.  LC
then assumes all distances are in inches and all feedrates are in inches/minute.
For compatibility reasons, LC accepts G70 as equivalent to G20.

The G21 command indicates that all G-Code commands are in metric units.  LC
then assumes all distances are in millimeters and all feedrates are in
millimeters/minute.  For compatibility reasons, LC accepts G71 as equivalent to
G21.

When using G20 or G21, there are several things to keep in mind:

• If you don’t use either command, LC assumes all program values are
consistent with the Display Units setting in the System Options dialog
box.

• You may only use one of these two commands in any G-Code
program, so all values in a G-Code file must use the same unit system.

G28 Return to Reference Point

The G28 command moves the tool at the rapid rate to the Tool Change Position
defined in the Machine Tool Setup dialog box.  This position is defined in
Machine Coordinates, so Machine Zero must be set for this command to be used.
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If the move contains positive Z movement, the machine first moves up in the Z
axis and then moves across in the XY plane.  If the move contains negative Z
movement, the machine first moves across in the XY plane and then moves down
in the Z axis.

If you want the G28 command to move only one or two axes, you can limit the
movement to those axes by adding the parameters “X0”, “Y0”, or “Z0” after the
G28 command.  Then, LC moves only the indicated axes to their Tool Change
Position coordinates.  A typical use is to only raise the Z axis for a manual tool
change (“G28 Z0”).

Example:

The Tool Change Position is defined as Machine Coordinate X=1, Y=1, Z=-1.

G01 X1.5 Y2.5 Z-3 F10 Linear move to the Program Coordinate
X=1.5, Y=2.5, Z=-3

G28 Z0 Rapid move in the Z axis only to Machine
Coordinate Z=-1

G01 X1.5 Y2.5 Z-3 F10 Linear move to the Program Coordinate
X=1.5, Y=2.5, Z=-3

G28 Rapid move in the Z axis to Machine
Coordinate Z=-1 followed by a rapid move
in the XY plane to Machine Coordinate
X=1, Y=1

G01 X1.5 Y2.5 Z-3 F10 Linear move to the Program Coordinate
X=1.5, Y=2.5, Z=-3

G28 X0 Y0 Z0 Rapid move in the Z axis to Machine
Coordinate Z=-1 followed by a rapid move
in the XY plane to Machine Coordinate
X=1, Y=1 (identical to the G28 command
with no parameters specified)

G29 Return from Reference Point

The G29 command moves the tool to the designated XYZ coordinate at the rapid
rate.

If the move contains positive Z movement, the machine first moves up in the Z
axis and then moves across in the XY plane.  If the move contains negative Z
movement, the machine first moves across in the XY plane and then moves down
in the Z axis.

Example:

The Tool Change Position is defined as Machine Coordinate X=1, Y=1, Z=-1.

G01 X1.5 Y2.5 Z-3 F10 Linear move to the program coordinate
X=1.5, Y=2.5, Z=-3
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G28 Rapid move in the Z axis to Machine
Coordinate Z=-1 followed by a rapid move
in the XY plane to Machine Coordinate
X=1, Y=1

G29 X2  Y3 Z-2 Rapid move in the XY plane to Program
Coordinate X=2, Y=3 followed by a rapid
move in the Z axis to Program Coordinate
Z=-2

When using G29, there are several things to keep in mind:

• You do not need to specify all three coordinates, only the ones for which you
want movement.

Example:

G29 X4.0 Y3.0 Moves the tool to Program Coordinates
X=4.0, Y=3.0, leaving the Z position
unchanged.

• The interpretation of the coordinates depends on the G90/G91 command in
effect.

G43, G44, G49, M06 Tool Change and Tool Length Compensation
Commands

LC supports tool changes and tool length compensation.  Tool length
compensation lets LC account for differences in tool lengths, so the G-Code
program can be created without regard to specific tool lengths (except for possible
interference problems).

THESE COMMANDS ARE NOT FOR THE NOVICE CNC USER.  WHEN
NOT PROPERLY USED, TOOL LENGTH COMPENSATION CAN CRASH
THE MACHINE TOOL, CAUSING SERIOUS DAMAGE TO YOUR
WORKPIECE OR MACHINE TOOL.

When applying tool length compensation, LC uses the Length Offsets defined in
the Tooling Setup dialog box.  See “Tooling Settings” in the Initial Setup section
for more information on defining your tools.

For tool length compensation to work properly, LC must know what tool is in use
at all times, including the tool that’s loaded when you start running a G-Code file.
Therefore, before you run a G-Code file that uses tool length compensation, you
must first choose your starting tool from the Current Tool pull-down menu on the
main screen.

To indicate tool changes in the G-Code file, use the M06 command as follows:

M06 Tn

where n is the tool number in the Tooling Setup dialog box.

Example:
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M06 T3 Pauses program, displays dialog informing
operator to change to tool number 3

Note:  For compatibility reasons, the T command can be used on any line prior to
the M06 command; it does not need to be on the same line as M06.

Once the M06 command has set the current tool, the G43 command applies the
proper offset to account for the current tool’s length as follows:

G43 Hn

where n is the tool number for the current tool.

The G43 command tells LC to shift all subsequent Z axis moves away from the
workpiece (in the positive Z direction) by an offset amount.  The offset amount is
equal to the difference in lengths between the current tool when the G43
command is executed and the previous tool.  LC uses the Length Offset values in
the Tooling Setup dialog box to calculate the difference in lengths between two
tools.

Example:

G43 H3 Shifts all subsequent Z axis moves away
from the workpiece (in the positive Z
direction) by the difference in lengths
between tool number 3 and the previous tool

The G44 command is identical to the G43 command, except that it shifts all Z
axis moves in the direction opposite from G43.  Unless you are an experienced
CNC programmer and know how to use G44 correctly, G43 is the preferred
command.

The G49 command cancels tool length compensation.  It removes any offset that
LC has applied since the G-Code program began running.

When using tool length compensation there are several important things to keep in
mind:

• You must predefine all tools and tool lengths in the Tooling Setup
dialog box.

• It’s good practice to include an M06 tool change and a G43
compensation command for the first tool used, near the beginning of
the G-Code program.

• LC automatically cancels tool offset when it finishes processing a G-
Code file, or during any operation that ends the current run of the G-
Code file (such as resetting the program, opening a new program, and
so on.)  TO AVOID CRASHING THE MACHINE TOOL, IT IS
VERY IMPORTANT THAT YOU REMOVE THE CURRENT
TOOL FROM THE SPINDLE WHENEVER LC CANCELS TOOL
OFFSET.
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• The G43, G44 and G49 commands are modal, so the current tool offset
remains active until LC executes another tool offset command, or until
LC cancels tool offset as described above.  Note that you may only use
one type of tool length compensation (G43 or G44) in a G-Code
program.

• The M06 command does not move the machine tool to the Tool
Change Position.  This is done using the G28 command described
above.  It’s good practice to place the G28 command in the line
directly preceding the M06 command.

• It’s good practice to use the G43 command in the line directly
following the M06 command.

The following example illustrates proper use of the tool change and tool length
compensation commands.

Example:

The tool library is shown below.
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The first tool used in the program is tool #1, so it is selected in the Current Tool
pull-down menu on the main screen.  The tool change position is defined as
Machine Coordinates X=2, Y=2, Z=0.  Tool #1 is loaded in the machine tool.
Program zero has been set using tool #1.  Program zero is set at Machine
Coordinates X=0, Y=0, Z=-4.  The machine tool is moved to Program
Coordinates X=0, Y=0, Z=1 before the G-Code file is run.

G00 Z.25 Move the Z axis down to Program
Coordinates X=0, Y=0, Z=0.25, Machine
Coordinates X=0, Y=0, Z=-3.75

G01 Z-1.0 F10 Move the Z axis down to Program
Coordinates X=0, Y=0, Z=-1, Machine
Coordinates X=0, Y=0, Z=-5

G00 Z.25 Move the Z axis up to Program Coordinates
X=0, Y=0, Z=0.25, Machine Coordinates
X=0, Y=0, Z=-3.75

G28 Move the Z axis up and the X and Y axes
across to the Tool Change Position, Program
Coordinates X=2, Y=2, Z=4, Machine
Coordinates X=2, Y=2, Z=0

M06 T2 Change the tool to Tool #2.  All coordinates
remain unchanged.

G43 H2 Apply the tool length compensation for tool
#2.  The offset amount is 0.750 (2.250-
1.500).  The tool does not move.  However,
the Program Coordinates change to X=2,
Y=2, Z=3.25.  The Machine Coordinates
remain unchanged at X=2, Y=2, Z=0.

G29 X1 Y1 Z0.25 Move the X and Y axes across and the Z
axis down to Program Coordinates X=1,
Y=1, Z=0.25, Machine Coordinates X=1,
Y=1, Z=-3.0

G01 X3 Y3 Z-1 F20 Linear interpolation to Program Coordinates
X=3, Y=3, Z=-1, Machine Coordinates X=3,
Y=3, Z=-4.25

G28 Z0 Rapid move in the Z axis only to Program
Coordinates X=3, Y=3, Z=3.25, Machine
Coordinates X=3, Y=3, Z=0

M06 T3 Change the tool to tool #3.  All coordinates
remain unchanged.

G43 H3 Apply the tool length compensation for tool
#3.  The offset amount is –1.250 (1.000-
2.250).  The tool does not move.  However,
the Program Coordinates change to X=3,
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Y=3, Z=4.5.  The Machine Coordinates
remain unchanged at X=3, Y=3, Z=0.

G29 X4 Y4 Z0 Move the X and Y axes across and the Z
axis down to Program Coordinates X=4,
Y=4, Z=0, Machine Coordinates X=4, Y=4,
Z=-4.5

G01 X5 Z-1 Linear interpolation to Program Coordinates
X=5, Y=4, Z=-1, Machine Coordinates X=5,
Y=4, Z=-5.5

G28 Move the Z axis up and the X and Y axes
across to the Tool Change Position, Program
Coordinates X=2, Y=2, Z=4.5, Machine
Coordinates X=2, Y=2, Z=0

G49 Cancel Tool Length Compensation.  The Z
axis Program Coordinate changes by -0.500,
the difference in Length Offset between the
current tool (#3:  1.000) and the tool
displayed in the Current Tool pull-down
menu when the program first began (#1:
1.500).  The new Program Coordinates are
X=2, Y=2, Z=4.  The Machine Coordinates
remain unchanged at X=2, Y=2, Z=0.  At
this point the current tool should be removed
from the spindle.

G52 Local Coordinate System

The G52 command defines and activates a local coordinate system that LC uses in
place of your original Program Coordinates for all absolute positioning moves.
The X, Y and Z parameters indicate the offset from your original Program Zero
location to the origin for the local coordinate system.

For example, "G52 X1 Y2 Z-4" would activate a local coordinate system whose
origin is at a distance of 1, 2, -4 from the original Program Zero.

All absolute moves are made relative to the new local coordinate system.  To
cancel use of the local coordinate system in the middle of a G-code file, use the
command “G52 X0 Y0 Z0”.

When LC reads a G52 command, it displays a magenta dot in the Tool Path View
Port showing the origin of the local coordinate system.

Note that the local coordinate system only applies to the G-code file being
executed.  The G52 command has no effect on the Program Zero you set before
running the G-code file.  LC automatically cancels the local coordinate system
when it completes execution of a G-code file.
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Example:

G01 X1.0 Y3.0 Z-1.5 F12 Moves the tool directly to the Program
coordinate X=1.0, Y=3.0, Z=-1.5.

G52 X3 Y-7 Z0  Activates a local coordinate system with
origin at X=3, Y=-7, Z=0 relative to
Program Zero.  The machine tool does not
move.

G01 X1.0 Y10.0 Z2.0 Moves the tool directly to the point X=1.0,
Y=10.0, Z=2.0 relative to the local
coordinate system as defined by the G52
command above.

G52 X0 Y0 Z0 Cancels use of the local coordinate system.
All absolute moves are again relative to
Program Zero as you set it before running
the program.

G90 Absolute Positioning Mode

The G90 command puts the system into absolute positioning mode.  All XYZ
coordinates are treated as points relative to Program Zero (or a local coordinate
system set by the G52 command).  This command stays in effect until a G91
command occurs.

Note that absolute positioning is the default positioning mode for LC.  It is not
necessary to include this command in your G-code file if all your moves are
absolute.

G91 Incremental Positioning Mode

The G91 command puts the system into incremental positioning mode.  All XYZ
coordinates are treated as incremental move distances.  This command stays in
effect until a G90 command occurs.

Example:

G01 X1.0 Y3.0 Z-1.5 F12 Moves the tool directly to the Program
coordinate X=1.0, Y=3.0, Z=-1.5.  G90 is
assumed.

G91 All XYZ coordinates after this command
will be interpreted as incremental distances.

G01 X1.0 Y2.0 Z-0.5 Moves the tool a distance of X=1.0, Y=2.0,
Z=-0.5 from the current tool location.  This
corresponds to the Program coordinate
X=2.0, Y=5.0 Z=-2.0.
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G02 X1.0 Y-1.0 I0.5 J-0.5 Moves the tool using counter-clockwise
circular interpolation to the Program
coordinate X=3.0, Y=4.0, Z=-2.0 with a
center point at Program coordinate X=2.5,
Y=4.5, Z=-2.0.

G90 All XYZ coordinates after this command
will be interpreted as Program coordinates.

G01 X1.0 Y2.0 Z-0.5 Moves the tool directly to the Program
coordinate X=1.0, Y=2.0, Z=-0.5.

M00 Program Pause

The M00 command pauses processing of the G-Code program.  You can use this
command anywhere in the program.  By default, LC displays a dialog box to
inform you that it has paused processing.  You can control whether or not this
dialog box appears using the Message on M00 Program Pause checkbox in the
G/M Code Setup dialog box.

M30 End of Program

The M30 command ends processing of the G-Code program and automatically
resets the program to the top.

M98, M99, M02  Subroutine Commands

Subroutines allow you to eliminate repetitive programming.  LC supports the use
of subroutines with the M98, M99, and M02 (or M30) commands.  Use of these
commands is best explained through a simple example.  The following G-code
program uses one subroutine called "mysub":

Example:

G01 X1 Y1 F10 First line of main program.

M98 Pmysub Jump to subroutine “mysub”.

G01 X0 Y0 Continued execution after “mysub” ends.

M02 End of main program.

Omysub First line of the subroutine called “mysub”.

G01 X2 Y2 Continued execution within the subroutine.

M99 End of subroutine “mysub”.

In the main program, the M98 command causes program execution to jump to the
first line of the subroutine named "mysub".  Notice that the letter "P" must
immediately precede the name of the subroutine with no spaces.
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The subroutine definition begins with the letter "O" followed immediately by the
subroutine name with no spaces.  The subroutine must end with the M99
command as shown.  M99 causes program execution to jump back to the main
program, continuing with the line immediately following the M98 line (G01 X0
Y0 above).

The main program must end with M02, the "End of Program" command.  M02 is
not required in a G-code program unless there are subroutines defined below the
main program.  Subroutine names may include up to 10 alpha-numeric characters.

You may use as many subroutines as you like, but each must have a unique name
within the program file.  If necessary, you can "nest" subroutines, meaning one
subroutine may call another subroutine, which in turn may call another
subroutine, and so on.

MXX – Miscellaneous Device Control

Using the Output Lines Setup dialog box you can define up to 16 M codes to turn
on or off different devices through the output lines.  M Codes can also be used for
digital control of devices by turning on or off a group of output lines to be used as
digital input into the control lines of the device. See “Output Lines Settings” in
the Initial Setup section for details on how to set up the M codes.

Popular M codes include:

M03 Spindle On

M05 Spindle Off

M07 Mist Coolant On

M08 Flood Coolant On

M09 Coolant Off

F Feedrate Command

The F command is used to designate a feedrate.  The feedrate set with the F
command is modal (stays in effect until another F command occurs).  Specify the
feedrate in inches/minute for English units and millimeters/minute for Metric
units.

Example:

G01 X4.0 Y3.0 Z1.0 F7.0 Moves the tool to Program Coordinate
X=4.0, Y=3.0, Z=1.0 at a feedrate of 7.0
in/min

Program Comments

You can add comments to your program by enclosing them in parentheses.  LC
ignores anything enclosed in parentheses as shown below.

Example:
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(Move to beginning of the next feature)

G00 X1.0 Y3.0 (Ready to move Z axis down)

G00 Z-1.5

(Begin next feature)

G01 Z-1.6 F8

G01 X3.0 Y7.5
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5. Tutorial

Starting LC Software

Windows 3.1 or 3.11

To start LC, double-click on the LC icon in the LC Program Group.

A dialog will appear asking you if you want to start with the Controller online or offline.
At this point, choose the No, Start Offline button.  If you are running the Demo version,
choose Continue.

Windows 95, 98 or NT

To start LC, click on the Start button, select Programs, select LC, and then select the LC
icon.

A dialog will appear asking you if you want to start with the Controller Online.  At this
point, choose the No, Start Offline button.  If you are running the Demo version, choose
Continue.

Configuring LC
1. Refer to Section 2, “Initial Setup” to properly configure LC, your Controller, your

Stepper Motor Driver and your machine tool.  If you have already made a setup file or
want to use a predefined setup file do the following:

2. Choose Open Setup from the File menu.

Section
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3. Select the drive and directory where the setup file is located, then select the file and
choose OK.  Some setup files are supplied for various mills and lathes.  If a setup file is
not available for your machine, select LCXXX.STP, where “XXX” is the current
software version (eg. “LC141.STP” for version 1.21).  Note that LCXXX.STP is
based on the Sherline 5400, but is easily modified to accommodate any machine tool.

4. Go through the Setup menus as described in Section 3, Initial Setup.  Enter the values
that best describe your machine.

5. Choose All Coordinates from the View menu to make sure all four coordinate systems
are displayed.

Loading a G-Code File
1. Choose Open G-Code from the File menu.

 

2. Go to the directory where LC is installed and double-click on the file TUTOR.AGC.

The G-Code File TUTOR.AGC will now be loaded into LC and the screen should now
look like this:
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Notice how the G-Code listing appeared in the Program Listing Box and a red outline of
the tool path appeared in the Tool Path View Port.

Viewing the Tool Path
There are two viewing modes for the tool path:  the size of the entire machine tool
envelope and scale to fit.  Note that since the machine coordinates are not defined, the
window shows an area that is twice the size of the entire machine tool envelope.

Now let’s set the machine coordinates.  To do this:

1. Choose the Set button next to the Machine label in the Tool Position Box.  A dialog
box for setting the Machine Coordinate values appear.  Choose the Zero All button.
This tells LC that the current tool position will be defined as Machine Zero, or home.
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The coordinates previously shown as N/A will now be zeroed and a light blue box will
outline the entire tool envelope in the Tool Path View Port.

To view in scale to fit mode, choose Scale to Fit from the View menu.  The tool path will
now expand to the largest size possible in the Tool Path View Box.  Now choose the View
menu again and notice the check mark in front of the Scale to Fit menu item.  This means
that the Tool Path View Box is currently in scale to fit mode.  If you wanted to view the
entire machine tool envelope, you would choose Scale to Fit again, but for now let’s keep
the screen in scale to fit mode, so hit the escape key on your keyboard.
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Now let’s get familiar with the Tool Path View Box. Here are some important features:

Red Lines - Represent the entire tool path of the part to be cut.

Green Dot - Represents Program Zero, the origin of any G-Code program.

Light Blue Dot - Represents Machine Zero, also called Home.

Yellow Dot (not shown here) - Represents the current XY position of the machine
tool during the cutting (or animating) operation.

Blue Lines (not shown here) - Represent the portion of the tool path already cut.

Dotted Lines - Represent a rapid move.

Solid Lines - Represent a feedrate move

Blue Tool - Represents the current Z position of the machine tool during the
machining (or animating) operation.

Light Blue Lines - Represent the borders of the machine tool envelope.

Animating the G-Code File
Now we are ready to animate the tool path on the screen to verify the program.

1. Choose the Set button next to the Program label, then choose Zero All in the dialog box
that immediately follows.  LC sets all three program coordinates to 0.  This simulates
the tool being in the correct position before the program begins.

2. Choose the G-Code button in the Control Box to make sure LC is in G-Code mode.

3. Select the Step radio button so the G-Code Program will be executed one line at a time.
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4. Choose the Start button and watch the blue tool move down the Z axis scale. Also note
that LC has highlighted the next line in the Program Listing Box, indicating it has fully
executed the first line.

5. Choose the Start button again.  Notice the yellow dot, which represents the current
position of the tool, and the solid blue line, which represents the cutting move just
executed.

6. Now select the Continuous radio button and then choose the Start button again.  Watch
as the yellow dot moves along the tool path and as the path already cut turns blue.
Also notice the status of the machine tool in the message box.  At the end of the part
program, the message box will beep and tell you the file was successfully processed.

Editing a G-Code File
Now let’s get familiar with using the LC
editor.

1. Choose Editor from the File menu.

2. The editor dialog box will appear.

 

3. First, let’s change the cutting depth to
0.25” instead of 2.25”.  With your mouse
or your arrow keys, move the cursor to
the first line of G-Code that reads: G01 Z-
2.25 F5.0.  Change it to read: G01 Z-0.25
F5.0, then choose Update Tool Path on
the bottom of the editor screen.  Notice
how the red line along the Z axis, which
shows the total length of Z travel, shrinks
down to 0.25”.

4. Now, let’s change the diameter of the arc
we are cutting.  Move the cursor to the
line of G-Code that reads: G03 Y1.0 I0.0
J0.5.  Change it to read: G03 Y2.0 I0.0
J1.0.

5. To save your changes:

1.  Choose Save G-Code As from the editor’s File menu.

2.  Choose the drive you want from the Drives pull-down menu.

3.  Click on the folder you want in the Folder box.

4.  Type “tutor2.agc” in the File name box.

5.  Choose OK.

6. To close the editor, choose Exit.
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Connecting the Machine Online
Now you are ready to communicate with the Controller.  In this step we will put LC into
online mode.  Note that when in online mode, all moves will be performed by the machine
tool.  If you are running the Demo version of LC or do not have the means to go online at
this time, ignore this section and continue with “

Using the Jog Controls” below.

1. Make sure that the machine tool and Controller are connected properly as described in
Section 1, “Initial Setup”.

2. Turn on the Controller.

3. Choose Online from the Controller menu.  After a short wait, a dialog box should
inform you that the controller is now online.

 

Using the Jog Controls
The jog controls let you manually position the tool to any position within the machine tool
envelope.

1. Choose the Jog button in the Control Box.  This will put LC into Jog mode.

2. Select the Slow radio button.  In this mode the machine tool will move at the Slow Jog
Rate defined in the Feedrate/Ramping Setup dialog box.  If you are offline, the jog rate
on the screen is determined by the speed of your CPU.

3. Look at the machine tool envelope to make sure there is enough room to move the tool
in the Z+ direction.  If there is enough room, click down, hold and release the Z+ Axis
Jog button.  Notice how the tool moved up and the Z program and relative coordinates
changed.  Also notice how the machine moved until you released the button.  If the tool
went down instead of up, change the motor polarity for the Z axis in the Machine Tool
Setup menu as described in Section 1, “Initial Setup”.   Note that if Machine
coordinates are properly set (described in the next section, “Setting Machine Zero”),
LC will not let you move beyond the machine tool envelope.  Note that you can also
jog the machine using the keyboard.  The controls are mapped as follows:
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 X+ Ctrl + Right Arrow Key
 X- Ctrl + Left Arrow Key
 Y+ Ctrl + Up Arrow Key
 Y- Ctrl + Down Arrow Key
 Z+ Ctrl + Page Up Key
 Z- Ctrl + Page Down Key
 

4. Try the same for all directions on all axes, making sure you have enough room in the
direction of travel before you choose each Axis Jog button.

5. Now select the Fast radio button and do the same exercise as you did for the Slow Jog
mode.  The tool will move at the Fast Jog Rate defined in the Feedrate/Ramping Setup
dialog box.

6. Position the tool so there is at least 1” of room in the positive Z direction.

7. Now let’s set the current position as Program Coordinates X=0, Y=0, Z=1.  To do this,
choose the Set button next to the Program label in the Tool Position Box, then choose
the Zero X and Zero Y buttons and enter 1.0000 in the Z text box.  Choose OK to exit
the dialog.

8. Now let’s use the Axis Jog buttons to move the tool up exactly 1.0000”.  It will be best
to use all three jog modes to do this: Fast, Slow and Single Step.

9. While LC is still in fast jog mode, move the tool up until the Z axis Program coordinate
is close to 2”.

10. Now change to slow jog mode and do the same to get even closer to 2”.

11. Finally, change to single step jog mode.  This will move the tool exactly one step each
time you choose one of the Axis Jog buttons.  Repeatedly choose either the +Z or -Z
Axis Jog buttons until the tool is exactly at Program coordinate 2.0000 on the Z axis.
Depending on the resolution of your machine tool, you might not be able to reach
2.0000 exactly.

12. Now use the same process to move the tool exactly 0.5000 inches in the +X direction
and 0.2500 inches in the +Y direction.  The Program coordinates should now read:

 X 0.5000

 Y 0.2500

 Z 2.0000

Setting Machine Zero
You can set Machine zero by either jogging the tool to the corner of the machine tool
envelope or by going into home mode and finding home for all 3 axes.  In this tutorial we
will jog to a point and define it as Machine Zero.

1. Choose the Home button in the Control Box.  This will put LC into Home mode.
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2. Choose the Clear Machine Zero button.  This will clear the machine coordinates and
remove the light blue Machine Tool Envelope.

3. Choose the Jog button in the Control Box.  This will put LC into jog mode.

4. Jog the tool to 1/10” from the top of the Z axis.

5. Jog the table in the X- direction to about 1/10” from the end of travel.

6. Jog the table in the Y- direction to about 1/10” from the end of travel.

7. Choose Set next to the Machine label.  Choose Zero All in the dialog box.

Using the Point Move
There is an even easier way to move the tool to an exact position, using the point mode of
the Control Box.

1. Choose the Point button in the Control Box.

2. From the Name pull-down menu select Any Point.

3. From the Coord pull-down menu select Machine.

4. Fill in the X Y and Z point coordinates to read 1, 2, -1.

5. Enter “4” in the Feedrate box.  The machine is now set up to move to the machine
coordinate 1, 2, -1 at a feedrate of 4 in/min.

 

6. Now choose the Start button.  Notice how the machine first performed 2-Axis linear
interpolation for the X and Y axis and then moved the Z axis down.  This sequence of
movement, unique to the point mode, helps to avoid tool crashes.

7. From the Name pull-down menu select Machine Zero.

8. Select Rapid from the Rate pull-down menu.  The tool is set to move to Machine
Coordinate 0, 0, 0 at the rapid feedrate.
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9. Now choose the Start button.  Notice how the machine first moved the Z Axis up and
then performed 2-axis linear interpolation for the X and Y axes.

Setting Program Zero on the Machine Tool
Program Zero is the origin to which all Program coordinates in the G-Code file are
referenced.  Before we cut a part, Program Zero must be set to a point from which we want
the G-Code file to begin processing.  For this tutorial we will cut a file called
LCBLT.AGC .

1. Choose Open G-Code from the File menu and select LCBLT.AGC, then choose OK.
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2. Make sure there is enough room on all axes of the machine to run the current G-Code
file from the program zero point.  The LCBLT.AGC program needs +2.125 inches on
the X axis, +1.625 inches on the Y axis and -.55 inches on the Z axis.

3. Fixture a sheet of 1/8” or thicker plastic (preferably machine grade) or aluminum at
least 2” wide and 4” long onto the XY table of the machine tool. Be sure that all
clamps and fixturing tools are well out of the way of the tool during all parts of the
program.  This program will run best with a 1/16” endmill.

4. Jog the tool to the -X, -Y corner of the workpiece using Jog mode.  Now, carefully jog
the tool down in the Z axis until it just barely touches the top of the workpiece.  We
recommend using a feeler gage to do this and then jogging down the exact thickness of
the feeler gage to touch the part.

5. To define this point as Program Zero, choose the Set button next to the Program label,
then choose Zero All in the dialog that immediately follows.

6. Using either Jog mode or Point Mode, bring the tool up in the Z axis exactly 1.0” and
again define this point as Program Zero by choosing the Set button next to the Program
label and Zero All in the dialog that follows.  Note that this point is exactly 1” above
where it needs to be to actually cut the workpiece.  The machine is now ready to do a
“dry run” without cutting the workpiece.

Testing the Program on the Machine Tool
It is always a good idea to do a “dry run” of the G-Code file both in offline and online
modes before cutting a part.  This way you can make sure the tool behaves as intended
before cutting the part.

1.  Put LC into G-Code mode by choosing the G-Code button in the Control Box.

2.  Make sure the G-Code program is reset by choosing the Reset button on the Control
Box, then OK in the confirmation dialog.

3.  Take the Controller offline by choosing Offline from the Controller menu.

4.  Go into step mode by choosing the Step radio button in the Control Box.

5.  Repeatedly choose the Start button, watching the screen to make sure the tool behaves
properly.

6.  Once you are satisfied the program will behave properly, re-establish communications
with the Controller by choosing Online from the Controller menu.  A dialog will ask
you if you want to revert to the coordinates used before going offline.  Choose OK.

7.  Go into step mode by choosing the Step radio button in the Control Box.

8.  Choose the Start button.  The machine should move in the X and Y axes and then stop.
Note that everything else is identical to offline mode.

9.  Step through the entire program by choosing the Start button for every line of G-Code.
If you have to stop the tool at any time, you can either choose the Feed Hold button
with your mouse or hit any key on your keyboard.  If you stop the tool in the middle of
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the program, you can start exactly where you left off by choosing the Start button.  You
may want to try this for practice.

Cutting the Part
Assuming everything was fine in the previous step, we are ready to cut an actual part.

1. Check to make sure the Program Coordinates are at 0,0,0.  If not, go through the
“Setting Program Zero on the Machine Tool” section above.

2. Now go into jog mode and carefully move the tool down in the Z- direction to the part
surface. This should be at the program coordinate 0,0,-1.

3. Set this point as Program Zero by choosing the Set button next to the Program label
and Choosing Zero All in the following dialog.

4. Now jog the tool 0.5” up in the Z+ direction.  This places the tool in the correct starting
position to begin cutting the workpiece.

5. Go back into G-Code mode by choosing the G-Code button in the Control box.

6. Go into continuous mode by choosing the Continuous radio button.

7. Turn the machine tool spindle on and make sure everything is ready on the CNC
Machine.

8. Choose the Start button and the CNC Machine will begin to cut out your first part.
Always be on alert to choose the Feed Hold button or hit any key in case of
emergency.

9. Congratulations, you’ve successfully cut your first part using LC!

Exiting the Program
To exit LC choose Exit from the File menu. This will close communications with the
Controller and return you back to Windows.

Turning off the Controller

 

 

 

 

 

  Always turn off the Driver Pack when not in use.
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6. I/O CONNECTIONS
 

WIRING
 BE VERY CAREFUL WHEN DOING ANY WIRING. IMPROPER WIRING WILL
DAMAGE THE MOTOR SIGNAL GENERATOR.

 The receptacle that plugs unto this connector is a Molex-Waldom Mini –Fit Jr. Series 16
pin receptacle (part number 39-01-2160), the female pins (part number 39-00-0039). The
input lines as seen on the package as arranged as follows:

 

 

 

 

 

 

 

 INPUT – The connector for up to 8 input lines. The most common use of the input is for
limit or safety switches. These lines are all TTL level inputs. When a switch is open, its
input signal is High (+5V). When a switch is closed, its input signal is Low (0V).

 All switches can be wired normally open (NO) or normally closed (NC), Software
Selectable. Each Normally Closed System must have all unused inputs wired to ground
(0V). Each Normally Open System must have all unused inputs left Open. When any of the
inputs line are open the Red Limit Light will illuminate and a signal will be sent to the host
PC to indicate which input line(s) went high.

 

 If you are not using the input lines, the limit light will always be illuminated.

 If you experience unexpected limit errors, make sure that the Signal Generator
Model 401A option is chosen in the System Options setup screen and all input lines
are properly defined in the Input Lines Setup screen.

 

 OUTPUT – The connector for up to 8 output lines. These lines are all optically isolated,
TTL level outputs. Low is 0V and High is +5V.

 

 

 

Section
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 BE VERY CAREFUL WHEN DOING ANY WIRING. IMPROPER WIRING WILL
DAMAGE THE MOTOR SIGNAL GENERATOR.

 The output lines are all initialized to low (0V) when you turn on the Motor  Signal
Generator.

 The receptacle that plugs unto this connector is a Molex-Waldom Mini –Fit Jr. Series 10
pin receptacle (part number 39-01-2100), the female pins (part number 39-00-0039). The
input lines as seen on the package as arranged as follows:

TYPICAL OUTPUT CONFIGURATION
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7. Driver  (BLD72 SERIES DRIVER)

BILEVEL DRIVE

The basic function of a step motor driver is to provide the rated motor phase current to the
motor windings in the shortest possible time. The bilevel driver uses a high voltage to get a
rapid rate of current rise in the motor windings in the least amount of time. When reaching
the preset trip current, the driver turns off the high voltage and sustains the current from
the low voltage supply.

HALF-STEP/FULL-STEP

Users have a choice of full-step operation or half-step operation.  Full-step operation
occurs by energizing two phases at a time, rotating a typical motor  1.8 degrees per step.
Half-step operation occurs by alternately energizing one, and then two, phases at  a time,
rotating the motor 0.9 degrees per step.  Full-step operation is suggested for applications
that specifically require that mode, such as when retrofitting existing full-step systems.
To activate Full Step, jumper PIN 7 and PIN 8 on Driver Terminal Block.

MOTOR ON/OFF INPUT (Internally Connected)

The motor on/off input allows de-energizing a motor without disturbing the positioning
logic.  After re-energizing  the  motor,  a routine can continue. This reduces motor heating
and conserves power, especially in applications where motors are stopped for long periods
and no holding torque is required.  If holding torque is required (such as when lifting a
load vertically), then this function should not be used. This output is internally connected
to the Indexer. See  Section 8 Command Descriptions for further information on Current
Hold Command.

FAULT PROTECTION

There are 3 types of fault detection.  When a fault is detected, the driver turns off the motor
current and the red Fault LED indicates which type of fault occurred. (Located on the top
of the driver pack.)

1 LED - Slow Blink shorted wire in the motor or cable

2 LED - Fast Blink open wire in the motor or cable

3 LED - ON Steady ground fault (voltage shorted to 0V)

FAULT LED

If the driver goes into a fault condition, the fault may be reset by turning the power OFF
for at least 15 seconds or by pulling the RESET FAULT input (terminal 4) to a logic “0"
for at least 100ms.

Section
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SETTING THE KICK CURRENT

The Kick Current should be set to the Motor’s Rated Unipolar Current.  For example, a
34D309 is rated for 4.5A, so the Kick Current Potentiometer would be set somewhere
between the 4A and 5A indication.

GROUNDING

The unit should be properly grounded.  Shielded cable should be used to preserve signal
integrity.

MOTOR HOOKUP

The DPJ Series Driver Packs can drive 6-lead and 8-lead step motors rated from 1 to 7
amps/phase (unipolar rating).  It features a unipolar bilevel (dual voltage) drive technique
with short/open circuit protection (with a Fault LED).  This Driver Pack contains a 600
Watt fan cooled power supply.

MOTOR CONNECTIONS

All motor connections must be separated from input connections and all other possible
sources of interference.

IMPORTANT NOTE: When wiring from the driver(s) to the step motor(s) that extends
beyond 25 feet, it is important to consult with the factory.
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8. Glossary
Backlash - The amount of motor movement that occurs without table movement when

changing directions.  This is usually due to the amount of “slop” between the nut and the
screw in the drive system.

Baud Rate - The speed at which LC communicates across the serial port with the Controller.
It is measured in bits per second and is typically set at 38,400.

Buffer Time - The Buffer Time is used to prevent system events from affecting motor
movement. The larger the Buffer Time, the less effect system events have on motor
movement.  The smaller the Buffer Time, the more responsive the machine tool is to
mouse clicks.

Stepper Motor Driver - The electronic box that converts step and direction signals from the
Controller into a sequence of amplified signals to drive a stepper motor.

Controller - The electronic box that converts computer commands into step and direction
signals for input into a Stepper Motor Driver.  It also interprets input signals and creates
output signals to control various peripheral devices.

CNC Setup Parameters - LC settings that are unique to each machine tool.  You can set
these settings in the Machine Tool Setup, Feedrate/Ramping Setup, System Options, and
Import Setup dialog boxes.  The coordinate display mode is also a CNC Setup Parameter.
All of these settings are saved in a setup file.

Command Buttons - Buttons which perform a certain task when chosen.

DXF - Document Exchange Format.  Defined by AutoDesk Inc. as a way to exchange CAD
files between different CAD, CAM or CAE programs.

Feedrate - The linear speed of the cutting tool relative to the workpiece.  Defined in G-Code
by the F parameter in inches/minute.

Full-Step - Step mode where one step from the controller corresponds to one full step of the
motor.

G-Code - Standard programming language used to control a CNC machine.

Gear Ratio - The ratio of the number of stepper motor revolutions to drive screw revolutions
due to any gears or pulleys between them.

Half-Step - Step mode where two steps from the controller correspond to one full step of the
motor.

Jog - Method of manually controlling the motors of the machine tool on any axis in any
direction.

Limit Switches - Switches placed at the end of travel of each axis.  When the machine tool
table travels too far in either direction of any axis, a limit switch is tripped, which will
shut down the system to prevent damage.

Machine Coordinates - The XYZ position of the tool on the CNC Machine relative to
Machine Zero.

Machine Origin - Same as Machine Zero.

Machine Tool Envelope - The three dimensional box defined by the maximum travel in the
X, Y and Z axis.  Once the machine tool envelope is defined, the tool cannot move
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outside of it.  The machine tool envelope can be disabled by clicking on the Clear
Machine Zero button in Home mode.

Machine Zero - The origin (X,Y,Z = 0,0,0) of useful space within the machine tool
envelope.  Can either be defined manually or by using home switches.

Maximum Feedrate - The maximum rate at which a motor (or an axis) can reliably start and
stop (with ramping).

Maximum Unramped Feedrate - The maximum rate at which a motor (or an axis) can
reliably start and stop without ramping.

Modal - Modal commands stay in effect until another command in the same mode group is
encountered.

Motor Polarity - The association between the actual direction an axis moves and the
direction LC thinks it’s moving.  If they are different, this value should be changed from
positive to negative or vice-versa.

Motor Resolution - The number of full motor steps for one revolution of the motor.  For
example, a 1.8° Stepper motor will have 200 full steps per revolution, a 0.9° Stepper
Motor will have 400 full steps per revolution, and so on.

Motor Step - The amount of movement associated with one electric pulse to the stepper
motor.  This will vary depending on the step mode and the steps per motor revolution.

Offline - Mode in which LC does not communicate with the Controller.  (also called
animation mode.)  All G-Code, Jog, and Point moves appear on the screen, but the
machine tool will not move.

Online - Mode in which LC directly communicates with the Controller.  In this mode, all G-
Code, Jog and Point moves are executed by the machine tool.

Open Loop - A control system in which a device receives a command and executes the
command without communicating back that the command was completed successfully.
Most stepper motor systems are open loop due to there high reliability in performing step
commands when used within their torque limits for a given RPM.

Part Program - Program used to control the movement of the machine tool.  G-Code is a
part programming language.

Program Coordinates - The XYZ position of the tool on the CNC machine relative to
Program Zero.

Program Listing Box - The area of the main screen that shows a listing of the part program
currently loaded in LC.

Program Zero - The zero point, or origin, to which all absolute coordinates in the G-Code
file are referenced.  It is depicted as a green dot in the Tool Path View Port.

Pull-Down Menu - A standard Windows control that lets you select a single item from a list.

Quarter-Step - Step mode where four steps from the controller correspond to one full step of
the motor.

Radio Buttons  - A group of options requiring a single selection, like the channel buttons on
your car radio.

Ramping - Method of accelerating a motor at increasingly faster step rates in order to reach
high feedrates.  Ramp rates are measured in full steps/sec/sec.  When ramping is used a
motor will accelerate and decelerate at the same ramping rate.
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Relative Coordinates - The XYZ position of the tool on the CNC machine relative to the point at
which the Relative Coordinates were zeroed. The relative coordinate system is general purpose
and may be used for anything you choose.

Resonant Speeds - Rotational speeds at which a stepper motor will vibrate excessively.  Quite often,
the motor will stall if run at these speeds.  This is dependent on the size of the motor, the size of
the load it is driving, and the power of the controller.  Typically, increasing loads and reducing
controller current will reduce resonance.

Screw Thread - The number of turns per inch of travel of the helical drive screw for each axis.

Serial Port - A communications port on both the PC and the Controller used to exchange commands
and information.

Setup File - A file containing the CNC Setup Parameters for a machine tool. These files have a
“.STP” extension by default.

Step Mode - The number of mini, or micro steps between each full motor step. The default step
mode in LC is Quarter-Step, or four micro steps between each full motor step.

Stepper Motor - A motor that moves a precise amount when given an electrical pulse. Stepper
motors typically have 200 full steps per revolution, or 1.8° per full step.  Other popular stepper
motors have 0.9° and 7.5° per step.

Text Boxes - Areas in which you type either a name or a value.

Tool Path - The path that a machine tool moves as a G-Code program is executed.

Tool Path View Port - The area of the main screen that graphically displays the tool path in real
time.

Tool Position Box - The area of the main screen that shows the current coordinates of the tool on the
machine tool.  You can display any one or all of the four coordinate systems in this box.

Tool Positioning Resolution - The amount of machine tool movement on a given axis that
corresponds to one step of the stepper motor.  Note that one step is either one Full-Step, one
Half-Step or one Quarter-Step depending on the step mode of the Stepper Motor Driver. Tool
Positioning Resolution (TPR) depends on 4 factors:  Step Mode (SM), Gear Ratio (GR), Motor
Resolution (MR), and Screw Thread (ST), where

TPR = 1 / (SM * GR * MR * ST)
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